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1.0 Introduction
Unlike many other solutions, ASTi's high-level architecture (HLA) implementation takes full
advantage of the flexibility and interoperability that the DoD for Modeling & Simulation
(DMSO) envisioned for HLA 1.3. ASTi has since expanded Telestra to support HLA Evolved
(HLAe). The Telestra server's industrial, off-the-shelf technology also provides increased
HLA performance and reliability.

HLA software is highly flexible, with capabilities that support HLA operation for radio and
communication models:

l Support for multiple run-time infrastructure (RTI) vendors

l An established and published ASTi radio simulation object model (SOM) and Real-
time Platform Reference (RPR) Federation Object Model (FOM) support

l Agile FOM capabilities

l Back-channel communication option

l Debug monitoring and log capabilities

l Dynamic run-time configuration changes (e.g., change HLA-associated files without
reinstalling the project)

Unfortunately, this flexibility comes with added complexity. HLA is both a standard and an
architecture. Unlike DIS, where Transmitter and Signal PDU formatting is fixed, HLA can
define each object's structure and interaction on the network. There are many ways to set up
audio-related objects and interactions. HLA is riddled with complex parts, such as the RTI
version, RTI Initialization Data (RID) file, mapping file, and federation file. These pieces all
affect the final, on-wire data structure. As a result, HLA implementation seldom allows for a
plug-and-play system.

The following chapters discuss how to:

l Choose a compatible HLA RTI file

l Install an RTI file

l Set up the HLA federation in Studio

l Set the default project and layout

l Join the federation at HLA run time

To download a sample HLA project, go to “Telestra App Note #126: Sample HLA Project for
Telestra 7.3.0 and Later” at support.asti-usa.com/appnotes/126.html.
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2.0 Choose a compatible HLA RTI file
Run-time infrastructure (RTI) is a middleware required for HLA implementation. This soft-
ware coordinates federate operations and data exchange during a run-time execution. Each
RTI has an associated RTI Initialization Data (.rid) or equivalent (e.g., .mtl, .settings) file that
configures RTI-specific initialization parameters.

ASTi is involved with an ever-growing number of high-level architecture (HLA)-based com-
munication simulations for a variety of programs throughout the U.S. and internationally.
From experience, each HLA program has its own set of unique problems dependent on the
equipment, software, and simulation deployed. Therefore, ASTi cannot guarantee there is
zero risk of any issues arising with the currently supported set of run-time infrastructures
(RTIs). No set of tests can verify all aspects of operation.

ASTi must test a complex set of variables together in their target environment under oper-
ational conditions:

l RTI operation, vendor, and software version

l RTI Initialization Data (.rid), MAK (.mtl), or .settings file configurations

l Network operation and conditions

l Simulation software

l HLA use in a network environment

2.1 Supported HLA RTIs for Telestra 7.X
Choose the proper RTI based on GCC compatibility and the requirements of your operating
system(s) or other HLA-related software. If you are interested in an unlisted RTI, contact
ASTi to discuss the possibility of expanding our HLA software. Minor version changes from
the RTI vendor do not typically impact our software's ability to run the RTI major version.

Requirements: RTIs must be 64-bit, GCC 4.8, and HLA 1.3 or HLA Evolved (HLAe) com-
patible.
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The current HLA functionality is based on HLA 1.3 and HLAe testing. The Telestra 7.X soft-
ware series supports the following HLA RTIs:

Vendor Version File Name Telestra Software

HLA 1.3 RTIs

MAK 4.5c makRti4.5c-linux64-rhe7.tar.gz 7.3.0 or later

RTI-s D35G, GCC 4.8 rtis_D35G_x86_64_g++-4.8.tar.gz 7.3.0 or later

HLAe RTIs

MAK 4.5c makRti4.5c-linux64-rhe7.tar.gz 7.3.0 or later

RTI-s D36C, GCC 4.8 rtis_D36C_x86_64_g++-4.8.tar.gz 7.3.0 or later

Pitch 5.5.0.0 prti1516e_5_5_0_0_linux64_
b189.rpm

Note: ASTi tested GCC 4.1
because GCC 4.8 was unavailable;
however; these versions are com-
patible.

7.8.0 or later

Table 1: Telestra 7.X HLA RTI compatibility
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3.0 Install and activate an RTI file in the Telestra
web interface
This section discusses how to:

l Install an HLA RTI file

l Activate an RTI file

3.1 Install an RTI file
Important: Telestra web interface access is disabled on hardened Telestra systems. There-
fore, you must manually upload and install the RTI from the Linux command line. Altern-
atively, install the RTI from the Telestra web interface before hardening your system.

To install the RTI file in the Telestra web interface, follow these steps:

1. If you have not done so already, insert a USB License Key with an active HLA license
file into the Telestra server. To learn more about licensing, go to "LicensingLicenses"
in the Telestra Web Interface User Guide.

2. On the left, go to Simulation > Protocols.

Figure 1: Protocols navigation

3. Go to the HLA tab.

4. Log in with the following default credentials:

Username Password

admin astirules
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5. (Optional) To view the hidden password, select Show Password ( ).

Figure 2: Login pop-up window

6. Select .

7. On HLA Management, select .

8. In Upload RTIs, select , and find up to five RTI files on your local system.
Accepted file types include tape archive GNU ZIP (.tar.gz, .tgz, .gz), shell script (.sh),
and Red Hat Packet Manager (.rpm).

Figure 3: Browse RTI files
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9. Review the RTI files to upload. To clear a file, select the trash can icon ( ).

Figure 4: Upload RTI file(s)

Select . The number of files on the button changes depending on your selec-
tion.

10. When the files are finished uploading, an “Upload is complete!” message displays, and
a check ( ) appears next to each green status bar. Close the pop-up window, and con-
firm the new RTI files appear in the RTIs table:

Figure 5: New RTI file in the RTIs table

Note: Telestra supports multiple RTI versions and vendors; however, only one may
be active at a time.

11. (Optional) To delete an RTI from the RTIs table, select the RTI's corresponding trash
can icon ( ).
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3.2 Activate an RTI file
To activate a high-level architecture (HLA) run-time infrastructure (RTI) file, follow these
steps:

1. On HLA Management, choose an RTI file from the RTIs table. In the Status column,
turn on on the RTI's corresponding toggle switch, which now displays “Active:”

Figure 6: Active RTI file

2. (Optional) If your RTI vendor requires the RTI to withdraw a license from an external
license server, do the following:

a. In License Host, enter xxx.xxx.xxx.xxx, where xxx.xxx.xxx.xxx is the license server's
IP address.

b. In License Port, enter the license server's port number (e.g., 27001).

Figure 7: RTI License Host and License Port

Note: Alternatively, you may configure a Pitch RTI license in the Local RTI Com-
ponent (LRC) .settings file. Go to Pitch documentation for more information.
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3.3 Set the HLA standard
To set the high-level architecture (HLA) standard, follow these steps:

1. From Simulation > Protocols, go to the HLA tab.

2. Log in with the following default credentials:

Username Password

admin astirules

3. (Optional) To view the hidden password, select Show Password ( ).

Figure 8: Login pop-up window

4. Select .

5. On HLA Management, select HLA Standard, and choose IEEE 1516e for HLAe or
HLA 1.3 for HLA 1.3.

Figure 9: HLA Standard
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4.0 Set up the HLA federation in Studio
The federation (.fed for HLA 1.3, .xml for HLAe) and mapping (.map.json) files on the
Telestra server define the audio communication interface to the HLA environment. The fed-
eration file provides the RTI with new federation execution details and potential routing
spaces, objects, and interactions. The mapping file tells the Telestra which objects and inter-
actions are of interest to the ASTi federate and where to find that data. The mapping file also
contains optional features related to object-naming conventions, Data Distribution Man-
agement (DDM), time stamp format, and more.

On the Telestra server, the mapping file reads the ASTi HLA radio environment class names
and hierarchies. The code does not compile this information, which allows the mapping file
to switch from one federation object model (FOM) to another. The mapping file provides
object class attribute and interaction class names to the Telestra server federate. It then directs
the Telestra server federate to find specific data in these attribute updates and interactions.

When designing your simulation object model (SOM) and FOM, consider units, data effi-
ciency, reliability, and coherence. You can then incorporate ASTi's SOM into your federation
object model, allowing the federation file and ASTi's mapping file to communicate. Altern-
atively, you can use ASTi's Real-time Platform Reference (RPR) FOM mapping file to lever-
age the RPR radio audio objects and interactions for radio communications.

The Telestra server can run HLA software on the same platform as the communication mod-
els (e.g., radios, network intercoms, engines). Figure 10, "Example HLA setup" below shows
an example configuration:

Figure 10: Example HLA setup
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This chapter discusses how to:

l Add an HLA domain

l Add an HLA configuration file

l Add a DIS gateway

l Connect the layout to the domain and gateway

l Set up HLA radios

4.1 Add an HLA domain
To add an HLA domain in Studio, follow these steps:

1. On an Studio development workstation, from the taskbar, go to Applications > ASTi
> Studio.

Figure 11: Studio navigation

2. From the top menu, go to Project > Open.

3. In Open Project, choose a project, and select .

Figure 12: Open Project

4. From the left menu, go to domains.
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5. Right-click the Icon View canvas, and select Add....

6. In New Domain plan, enter a unique name for the domain. Select .

Figure 13: Add a domain

7. On Names, select Add Domain ( ).

8. In Set Domain Name, enter a unique name for the domain (e.g., HLA_Domain).
Write down this name for future reference.

Figure 14: Set Domain Name

9. Under DIS, in Exercise ID, enter 1.
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10. (Optional) To automatically set IDs, select Set IDs to Last Two IP Octets. To set IDs
manually, select Set IDs Manually. In Site ID and App ID, enter numbers defining
the first two parts of the HLA 64-bit stream tag identifier.

To learn more about stream tags, go to “REAL-TIME PLATFORM REFERENCE
FEDERATION OBJECT MODEL” in SISO-STD-001.1-2015. To view stream tags in
ASTi's simulation object model, go to the Example HLA Project in App Note #126:
Sample Project for 7.3.0 and Later.

11. Select and .

4.2 Add an HLA configuration file
The HLA configuration file defines the default federation name, federate name, RID file, map-
ping file, and federation file. Because the Telestra server can define and use multiple con-
figuration files, you can create multiple HLA configurations and switch between them.

To add an HLA configuration file, follow these steps:

1. In Domain Editor, on the left, go to the HLA tab.

2. Select Add HLA File ( ).

3. In Create HLA File, enter a unique name for the file. Select .

Figure 15: Create HLA File

4. To add one or more HLA file(s) to a project, under File Management, select Browse,
and find the desired .rid, .map.json, .fed, .settings, or .xml files on your local system.
For a list of common federation and mapping files, go to Appendix A, "External
FED/FDD, RID, and mapping files" on page 32.
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5. On Required Parameters, in Federation Name, enter the name of the default fed-
eration the Telestra server will join.

Important: In Studio 7.3 and later, Advanced Parameters, Debug Level, and License
Server Configuration on Required Parameters are not operational. You can set up
this functionality in the mapping file or the Telestra web interface. For more inform-
ation about mapping files, go to Appendix A, "External FED/FDD, RID, and map-
ping files" on page 32.

6. In Federate Name, enter a unique federate name that the federation will see. Each
Telestra server appears as a federate in the federation.

7. In RID File, FED/FDD File, andMapping File, select the files you uploaded in Step
4.

Figure 16: Required Parameters

8. Scroll down to ASTi HLA Network, and enter the following:

a. IP: 127.255.255.255

b. Port: 54001

c. Int: eth0

9. Under ASTi HLA Host Control, in Port, enter the port number the host platform will
use to control the ASTi federate. For more information, go to Section 5.0, "Join the fed-
eration at HLA run time" on page 20.
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10. Select Interface, and choose an Ethernet interface (e.g., eth0).

Figure 17: ASTi HLA Host Control

11. Select and .

4.3 Add a DIS gateway
To add a DIS gateway, follow these steps:

1. From the left menu, go to servers.

Figure 18: servers navigation

2. Right-click in the Icon View canvas, and select Add.

3. In New Item, choose DIS Gateway.
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4. Enter a unique name for the gateway, and select .

Figure 19: New gateway settings

5. On Icon View, open the new gateway. DIS Gateway opens.

6. Under General, in version, enter 7.

7. Under Interfaces, select DIS Interface, and choose lo.

8. In port, enter 54001.

9. In main, enter 127.255.255.255.

Figure 20: DIS Gateway settings

Important: Ensure main and port match the ASTi HLA Network IP and Port values
that you set in Section 4.2, "Add an HLA configuration file" on page 12.

10. Select .

4.4 Connect the layout to the domain and gateway
To set the project layout to use the new HLA domain and DIS gateway configuration file, fol-
low these steps:

1. From the left menu, expand the project, and choose a layout.

2. Right-click the Telestra icon ( ), and select Edit.
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3. On CORE, select Domain, and choose the domain you created in "Add an HLA
domain."

Figure 21: Choose a domain

4. Go to SIM SERVER.

5. Select DIS Gateway, and choose the DIS gateway you created in "Add a DIS gate-
way."

Figure 22: DIS Gateway

6. Select . The Telestra server can now output HLA network traffic.

7. From the toolbar, select Project > Save.
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4.5 Set up HLA radios
Now that the Telestra server layout supports HLA traffic, you must choose which radios in
the layout will use HLA. These instructions assume the Telestra server already has a model
with radios. For more information about radio setup, go to the Studio Components Reference
Guide at support.asti-usa.com/telestra/index.html.

To set up Telestra radios for HLA, follow these steps:

1. From the toolbar, select Install Layout ( ).

Figure 23: Install Layout

2. When the confirmation message appears, select Yes. Wait about 30 seconds for the lay-
out to install.

3. In Icon View, open the Telestra server ( ).

4. In System Load, find a simulation model with radios.

5. Choose a radio in the model.
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6. On Views, open a radio Transceiver.

Figure 24: Open a Transceiver

7. To set the HLA domain name, find DomainName, and double-click Value.

8. In Set Value, enter the domain name you created in Section 4.1, "Add an HLA
domain" on page 10. Select .

Figure 25: DomainName value

9. To set the HLA stream tag, find ProtocolId, and double-click Value.
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10. In Set Value, enter a DIS: syntax command (e.g., DIS:1.2.3.4). If a specific stream tag
isn't required, enter DIS:, which ensures the radio stream tag is unique within the fed-
erate. Select .

Figure 26: ProtocolID value

11. From the top toolbar, select Apply changes to Project ( ). When the confirmation
message appears, select .

Figure 27: Apply changes to Project

12. Close the window. From the toolbar, select Project > Save.
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5.0 Join the federation at HLA run time
After installing the run-time infrastructure (RTI) software in the Telestra web interface and
setting HLA options in Studio, you must join the simulation federation via the Telestra
server. Telestra's built-in ASTi HLA Host Control feature allows you to join the federation,
view network activity, and complete other HLA tasks. ASTi also supports a host emulator
that acts as a remote control interface but can control a local or remote host.

This chapter discusses the following topics:

l ASTi HLA Host Control 

l Host emulator

l ASTi HLA Host Control commands and responses

l RTI Executive

5.1 ASTi HLA Host Control
The ASTi HLA Host Control feature allows you to control the Telestra server from a host
server, instructing the federate to join or resign from a federation. Access HLA Host Control
through a TCP/IP connection to the appropriate control port. Each federate has its own con-
trol port, as described in Section 5.1, "ASTi HLA Host Control " above. A control port can
only support one TCP connection at a time.

After gaining control of the federate, the host can command the federate to:

l View current federate settings (e.g., federate name, federation name, .rid file)

l Change federate settings (e.g., federate name from FED_A to FED_B)

l Join or resign a federation

l Check run-time infrastructure (RTI) network activity

l Enable HLA interface ingress logging

For a full list of commands, go to Section 5.2, "ASTi HLA Host Control commands and
responses" on page 22.

Changes that you make in HLA Host Control are temporary. Reinstalling the Studio project
or layout overwrites your changes. To make permanent changes, modify the HLA tab in the
Domain Editor. For more information about HLA settings in the Domain Editor, go to Sec-
tion 4.2, "Add an HLA configuration file" on page 12.
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The Telestra server interacts with the host computer using a three-way, TCP handshake pro-
cess. As part of this process, a single host computer connects to a Telestra server acting as a
TCP server. The Telestra server listens on the HLA Host Control TCP port for a SYN mes-
sage from the host computer. When it receives the message, the Telestra server responds with
a SYN-ACK message. In turn, the host responds with an ACK message.

After completing the handshake, the host and Telestra server can exchange data: the host com-
puter sends command request(s), and the Telestra server responds accordingly. The host may
terminate or reestablish the connection as needed. The host must reestablish a connection
when you install an Studio project.

Figure 28, "HLA Host Control interaction" below shows the TCP/IP-based HLA Host Con-
trol interaction:

Figure 28: HLA Host Control interaction

5.1.1 Host emulator

The Telestra server and Studio development workstation include a host emulator called
hostemu. This program acts as a console attached to the federate on a local or remote system.
You can use hostemu to test the remote interface and verify that it's working correctly.

To run the host emulator, follow these steps:

1. Open a terminal.

2. Log in using one of the following default credentials:

Telestra server:

Username Password

admin admin

Copyright © 2025 Advanced Simulation Technology inc. 21

HLA Installation Guide (Rev. C, Ver. 3)



Studio:

Username Password

aceuser aceuser

Note: If your organization changed these default credentials, check with your IT
administrator for an updated username and password.

3. To allow a Telestra server or Studio to act as a remote host to another Telestra server,
do one of the following:

l To connect to a local Telestra server, enter hostemu yyyyy, where yyyyy is the
Telestra server's port number (e.g., 45001) from the Studio project.

l To connect to a remote Telestra server, enter hostemu yyyyy xxx.xxx.xxx.xxx, where
xxx.xxx.xxx.xxx is the remote Telestra server's IP address. This command allows a
local Telestra server or Studio to act as a remote host to another Telestra server.

Once connected, hostemu acts as a console that sends user input to ASTi's HLA Host Con-
trol feature. If the host emulator's connection terminates, the socket automatically reopens and
listens for a new connection.

5.2 ASTi HLA Host Control commands and responses
Commands and responses in the HLA Host Control feature are text-based, readable messages.
While commands are not case sensitive, some data for the commands may be case sensitive
(e.g., the federation file name).

The Telestra federate expects all command lines to terminate with a new line character. When
the host sends two commands simultaneously, the federate executes them in order. The fed-
erate waits for the final new line before executing a command. To yield a new line, press the
Spacebar, and then press Enter.

5.2.1 Status

Status displays the state of the federate. It shows if the federate is JOINED to a federation,
RESIGNED from a federation, or READY to join a new federation. A DOWN response
means that an error has occurred. Go to /var/log/messages on the Telestra server for more
information.

Request

status
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Response(s)

JOINED

RESIGNED

READY

DOWN

5.2.2 Name

When called with no parameters, name returns the names of the federate, the federation, the
federation file, the RID file, and the mapping file.

Request

name

Response

FEDERATION ExampleFederation

FEDERATE ExampleFederate

FEDFILE /tmp/aced-
repoKwg3FX/repo/domains/FEDERATE1/hla/example.fed

RIDFILE /tmp/aced-
repoKwg3FX/repo/domains/FEDERATE1/hla/example.rid

CONVERT /tmp/aced-
repoKwg3FX/repo/domains/FEDERATE1/hla/example.map.json

Note: CONVERT displays the mapping file name.

These variables receive their initial values from the Project domain configuration on pro-
ject/layout install. After installation, you can temporarily rename the federation and federate
or substitute a federate, RID, or mapping file for testing purposes. Reinstalling the Studio pro-
ject or layout resets these changes to the default.

Request
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name FEDERATION {New_Federation_Name}

name FEDERATE {New_Federate_Name}

name FEDFILE {New_Fed_File_Name}

name RIDFILE {New_Rid_File_Name}

name CONVERT {New_Mapping_File_Name}

The name FEDFILE, name RIDFILE, and name CONVERT parameters only define the
file name. These file(s) must exist in the hla subfolder of the currently installed Telestra pro-
ject domain. You do not need to enter the full path.

Note: To reference files (e.g., federation, RID) outside of the project repository, go
toAppendix A, "External FED/FDD, RID, and mapping files" on page 32.

5.2.3 Activity

Activity returns activity counters from the Telestra server. Use this command to verify the
federate joined the federation or view troubleshooting information. On the Telestra server's
host emulator, you can also press Enter to initiate activity.

Request

activity

Activity responds with the following:

l Life count: a general indicator of federate health. The counter increments once a second
while the entity is joined to a federation. A fixed number indicates an error.

l Attribute updates: report the cumulative number of attribute updates that the federate
sends and receives. The attributes include radio object parameters, such as radio power,
world location, and frequency. An attribute update occurs whenever a field changes.

l Interactions: displays the number of interactions that the federate sends and receives.

l Objects: displays the number of transmitter objects on the HLA network. A trans-
mitter's local counter reflects the number of local transmitter objects, while the RTI
counter reflects the number of remote objects.
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Response

Life count: 10
<Attribute Updates>
rx: 50 | tx: 25
<Interactions>
rx: 382 | tx: 378
<Objects>
Transmitters | local: 13 | rti: 13

5.2.4 Join

Join directs the Telestra server federate to join the federation and optionally specifies the
name. You do not need to resign to join a different federation. Issuing a new Join command
resigns the Telestra server federate from its current federation before attempting to join the
new one. If the federate is already part of a federation, it automatically resigns and attempts
to rejoin, even if the federation name is the same.

Two federates must use the same federation name to exchange information. If the federate
has no name, the Telestra server uses the federation name from the Telestra server con-
figuration file. To learn more about Telestra server configuration file settings, go to Section
4.2, "Add an HLA configuration file" on page 12.

Request

join {optional federation name}

Response(s)

join {federation name} OK

join {federation name} FAIL

join {federation name} FAIL {federation file path}

Error joining federation, see log

Join may return four types of responses:

l join {federation name} OK: the federate successfully joined the federation. The system
is running, and you may now query the federate's STATUS and ACTIVITY.

l join {federation name} FAIL: the federate failed to join the federation. The following
issues usually cause a generic failure to join:
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o The RTI Executive is not running.
o The Telestra server's project does not specify a default federation name.
o The RTI does not have a license.
o A networking error occurs.
o The federation file does not contain the names in the ASTi Radio SOM.
o The Telestra server could not find the federation file in the specified location.

l join {federation name} FAIL {federation file path}: the federation can't retrieve
handles for all of the object class and attribute names it requested from the RTI. Usu-
ally, this error occurs because the object and attribute names in the federation file are
different in the mapping file. Contact ASTi at support@asti-usa.com for more inform-
ation.

l Error joining federation, see log: For more information, go to /var/log/messages on
the Telestra server. If the error is RTI-specific, contact support@asti-usa.com and/or
the applicable COTS/GOTS RTI vendor.

5.2.5 Resign

Resign prompts the Telestra server federate to leave the federation. The federate can't trans-
mit data, but it is still available on the network.

Request

resign

A successful resign responds with RESIGN OK. HLA-related errors (e.g., the system can't
communicate with rtiexec) usually cause a RESIGN FAIL. Check the Telestra server's sys-
tem log for more information.

Response(s)

RESIGN OK

RESIGN FAIL
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5.2.6 Openlog

This command logs all HLA networking objects and interactions that an attribute or para-
meter receives. When enabled, the log writes to a file located at /var/log/hla_debug on the
Telestra server. You might use openlog to debug, test, or verify networking operations. ASTi
does not recommend leaving openlog enabled for normal operations.

Important: This command logs all ingress HLA data; do not enable under heavy networking
conditions.

Request

openlog

The following response shows an example of network logs for the Radio Transmitter,
Radio Receiver, and EncodedAudio Interaction attributes from the ASTi SOM.

Response

6/20/2025 7:59:51 Reflect Attributes: Com-
municationSystem.RadioTransmitter

AntennaPatternData (7)[0]:

Encryption (1)[4]: 00 00 00 00 *....*

Frequency (2)[12]: 00 00 00 00 04 C4 B4 00 46 C3 50 00
*........F.P.*

RFModulation (3)[6]: 00 03 00 01 00 01 *......*

SpreadSpectrum (4)[0]:

TransmitState (5)[16]: 01 00 00 00 41 F0 00 00 01 00 00 01 E1 D4
9E 2B *....A..........+*

WorldLocation (6)[24]:

00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
*................*

00 00 00 00 00 00 00 00 *........*

11/15/2019 8:02:51 Reflect Attributes: Com-
municationSystem.RadioReceiver

ReceivedPower (1)[4]: C3 87 00 00 *....*
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ReceivedTransmitterIdentifier (2)[0]:

ReceiverOperationalStatus (3)[16]: 00 01 00 00 00 00 00 00 01 00
00 01 E1 D4 9E 2B *...............+*

11/15/2019 8:06:38 Receive Interaction: Radi-
oTransmission.EncodedAudio

StreamTag (2)[8]: 01 00 00 01 E1 D4 9E 2B *.......+*

EncodedParam (1)[208]:

00 01 1F 40 06 40 00 C8 7A ED 5A B6 91 86 81 80
*...@.@..z.Z.....*

83 8B 9D 34 11 07 01 00 03 0B 1D B4 91 87 81 80
*...4............*

83 8B 9D 34 11 07 01 00 03 0B 1D B4 91 87 81 80
*...4............*

83 8B 9D 34 11 07 01 00 03 0B 1D B4 91 87 81 80
*...4............*

83 8B 9D 34 11 07 01 00 03 0B 1D B4 91 87 81 80
*...4............*

83 8B 9D 34 11 07 01 00 03 0B 1D B4 91 87 81 80
*...4............*

83 8B 9D 34 11 07 01 00 03 0B 1D B4 91 87 81 80
*...4............*

83 8B 9D 34 11 07 01 00 03 0B 1D B4 91 87 81 80
*...4............*

83 8B 9D 34 11 07 01 00 03 0B 1D B4 91 87 81 80
*...4............*

83 8B 9D 34 11 07 01 00 03 0B 1D B4 91 87 81 80
*...4............*

83 8B 9D 34 11 07 01 00 03 0B 1D B4 91 87 81 80
*...4............*

83 8B 9D 34 11 07 01 00 03 0B 1D B4 91 87 81 80
*...4............*

83 8B 9D 34 11 07 01 00 03 0B 1D B4 91 87 81 80
*...4............*
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5.2.7 Closelog

Closelog disables HLA network logging.

Request

closelog

Response

DONE

5.2.8 Bye

Bye prompts the federate to exit the host emulator; however, the federate remains joined to
the federation.

Request

Bye

Response

(Closed by remote host)

5.2.9 Quit

Quit resigns the Telestra server from the federation and exits the host emulator. If successful,
it does not return a response.

Request

quit
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5.2.10 Help

Help returns a list of HLA Host Control commands:

Request

help

Response

Commands: activity, bye, closelog, help, join, name, openlog,
quit, resign, status

5.3 RTI Executive
The RTI Executive (rtiexec) is a global process that typically executes on a single platform.
In a large-scale distributed simulation, this process often manages a large number of com-
puting resources or federates. The rtiexec creates and destroys multiple federation executions
that have different names and monitor federate health. For example, the rtiexec might
coordinate timing (e.g., pause each federation execution simultaneously).

The rtiexec typically requires a desktop platform to operate (e.g., Linux, Windows computer,
or Mac, depending on the RTI vendor). While rtiexec may operate on Studio, ASTi is not
responsible for any errors that occur. For more detailed information specific to your con-
figuration, go to your vendor's HLA documentation package.

This chapter provides a top-level overview of the following RTI Executive processes:

l (Optional) MAK RTI Executive

l Pitch Central RTI Component (CRC)

5.3.1 (Optional) MAK RTI Executive

The Telestra federate or Local RTI Component (LRC) can operate without the rtiexec; how-
ever, your program's configuration and/or the federate's RID or MTL file settings may still
require its use. The rtiexec runs in conjunction with RTI Forwarders, which link different
sites over the WAN or distribute TCP traffic load over multiple machines. They can also com-
press or bundle network packets to optimize for throughput or processor utilization.
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Note: The following examples pertain to MAK RTIs, version 4.5c.

To initiate an RTI Forwarder, at the prompt, run the following:

Request

./rtiForwarder -M -R {.rid file path} -l {.log file path}

To start the rtiexec process, run the following:

Request

./rtiexec -M -R {.rid file path} -l {.log file path}

To set up and run the MAK GUI, RTI Executive, or RTI Forwarder, go to
MAK RTI documentation at Mak.com.

5.3.2 Pitch Central RTI Component (CRC)

The CRC (i.e., rtiexec) coordinates the entire federation and distributes work among the
Local RTI Components (LRC). When a federate wants to join a federation execution, it con-
nects to the CRC and receives information about the federation execution (e.g., other fed-
erates on the network). The Telestra federate or LRC requires a CRC on the network when
the host requests to join. The join fails if no CRC exists. Monitor execution via the CRC's
GUI or command-line interface.

To set up and run the CRC, go to Pitch pRTI documentation at pitchtechnologies.com/prti.
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Appendix A: External FED/FDD, RID, and map-
ping files
A Telestra project or model typically contains the federation (.fed, .xml), RID (.rid, .mtl, .set-
tings) and mapping files (.map.json). However, these files may also exist outside of a project.
While the file(s) can reside in any system directory, follow the structure below for ease of
implementation.

You may want to manage mapping files outside of the project to:

l Share mapping file(s) with other projects

l Administer project revision control outside of a Telestra project

l Leverage a storage area network (SAN) or file share

l Host scriptable or manageable files

Note: Creating a custom mapping file requires an advanced understanding of HLA concepts
or completion of ASTi's HLA training course. If your application requires a custom or fed-
eration-specific mapping file, contact ASTi at support@asti-usa.com for additional guid-
ance.

Customers receive the following files in Telestra’s baseline software:

File Type Telestra File Path Included Files

FED/FDD /opt/hla/feds l asti3_0.fed
l asti3_1.fed
l asti3_2.fed
l ASTi_SOM_v32_1.xml
l RPR2-D17.fed
l RPR_FOM_v2.0_1516-2010.xml

RID /opt/hla/rids None

Mapping /var/asti/hla/maps l astisom30_revA.map.json
l astisom_revA.map.json
l rprfom_revA.map.json
l t4rprfom_revA.map.json

Table 2: Included mapping files

Actual file names and revisions vary depending on the software release. For more inform-
ation, go to your software installation. You may add custom application or program-specific
files as needed. Since the above files are not part of a project, you must enable them using the
host platform controlling the ASTi federate.
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Configure the files using the “name” command available in the ASTi HLA Host Control
TCP/IP connection. For more information about “name”, go to Section 5.2.2, "Name" on
page 23. After installing the project, run the “name” command for each file that requires an
external project reference.

To update the FED, RID, and mapping files to external project files, follow these steps:

1. To connect to the host, at the prompt, run hostemu {port_number}, where {port_num-
ber} is the host’s port number.

[root@esxitarget1-730 rids]# hostemu 45001

Trying port 45001 on host 127.0.0.1

Connected to port 45001

Hit ctrl-c <enter> to quit

2. To check which files are in use, run name.

name

The Telestra server responds with the current federation and federate as well as the .fed
file, .rid file, and .map.json file (also known as a CONVERT file):

FEDERATION Sample

FEDERATE TelestraN

FEDFILE /var/tmp/aced-repoL3gLdj/repo/domains/FEDERATE_
N/hla/RPR2-D17.fed

RIDFILE /var/tmp/aced-repoL3gLdj/repo/domains/FEDERATE_
N/hla/mak_rid_asti.rid

CONVERT /var/tmp/aced-repoL3gLdj/repo/domains/FEDERATE_
N/hla/rprfom.map.json

3. To replace the current .rid file with an external project file, run name RIDFILE {file_
path}, where {file_path} is the name and location of the new .rid file.

name RIDFILE /opt/hla/rids/mak_rid_asti.rid
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In response, the Telestra server displays the new file path next to RIDFILE:

FEDERATION Sample

FEDERATE TelestraN

FEDFILE /var/tmp/aced-repoL3gLdj/repo/domains/FEDERATE_
N/hla/RPR2-D17.fed

RIDFILE /opt/hla/rids/mak_rid_asti.rid

CONVERT /var/tmp/aced-repoL3gLdj/repo/domains/FEDERATE_
N/hla/rprfom.map.json

Important: If using Pitch RTI, the .settings extension replaces the .rid extension.

4. To update the .fed or .fdd file to an external project file, run name FEDFILE {file_
path}, where {file_path} is the name and location of the external .fed or .fdd file.

name FEDFILE /opt/hla/feds/asti3_2.fed

In response, the Telestra server displays the new file path next to FEDFILE:

FEDERATION Sample

FEDERATE TelestraN

FEDFILE /opt/hla/feds/asti3_2.fed

RIDFILE /opt/hla/rids/mak_rid_asti.rid

CONVERT /var/tmp/aced-repoL3gLdj/repo/domains/FEDERATE_
N/hla/rprfom.map.json

5. To update the conversion or mapping file to an external project file, run name
CONVERT {file_path}, where {file_path} is the name and location of the external
mapping file.

name CONVERT /var/asti/hla/maps/astisom.map.json
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In response, the Telestra server displays the new file path next to CONVERT:

FEDERATION Sample

FEDERATE TelestraN

FEDFILE /opt/hla/feds/asti3_2.fed

RIDFILE /opt/hla/rids/mak_rid_asti.rid

CONVERT /var/asti/hla/maps/astisom.map.json

The host uses these files to join the federation until you update them or reinstall the
project.
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